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DIABLO ANALYTICAL, INC. 
SOFTWARE LICENSE AGREEMENT AND LIMITED WARRNTY 

 
LICENSE AGREEMENT 
 
IMPORTANT:  Please carefully read the License Agreement below before installing the software.  The right to use this 
software product is sold only on the condition that the customer agrees to the following license. 
 
INSTALLING THE SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS. 
 
In return for payment of the one-time license fee for this software product, Customer receives from Diablo Analytical, Inc. 
(Diablo) a license to use the product subject to the following terms and conditions: 
 
Use:  The product may be used on one computer or workstation. A separate license agreement and fee is required for 
each additional computer or workstation on which the product is used.  Customer may not reverse assemble, decompile, 
or modify the software. 
 
Copies:  The software product may not be duplicated or copied except for archive purposes, program error verification, or 
to replace defective media, and all copies made must bear the copyright notices contained in the original. 
 
Ownership:  Purchase of this license does not transfer any right, title or interest in the software product to Customer 
except as specifically set forth in this License Agreement.  Customer is on notice that the software product is protected 
under copyright laws. 
 
Transfer of Rights:  This license and the software product may be transferred to a third party, with prior written consent 
from Diablo, provided the third party agrees to all the terms of this License Agreement and the Customer does not retain 
any copies of the software product. 
 
Sublicensing and Distribution:  Customer may not sublicense the software or distribute copies of the software to the public 
in physical media or by telecommunication without the prior written consent of Diablo. 
 
Termination:  Diablo reserves the right to terminate this license upon breach.  In event of termination, Customer will either 
return all copies of the product to Diablo, or with Diablo's prior consent, provide Diablo with a certificate of destruction of 
all copies. 
 
Updates and Upgrades:  Customer agrees that the software does not include updates and upgrades which may be 
available from Diablo in a separate support agreement. 
 
Export Restrictions:  Customer agrees not to export or re-export the software or any copy in violation of the U.S. Export 
Administration regulations or other applicable regulation. 
 
LIMITED WARRANTY 
 
Limited Warranty:  Diablo warrants that the original disks are free from defects for 90 days from the date of delivery of the 
software. 
 
No Other Warranties:  To the maximum extent permitted by applicable law, Diablo expressly disclaims any warranty for 
the software product.  The software product and any related documentation is provided "as is" without warranty of any 
kind, either express or implied, including, without limitation, the implied warranties or merchantability of fitness for a 
particular purpose.  The entire risk arising out of use or performance of the software product remains with the customer. 
 
Limitation of Liability and Customer Remedies:  Diablo's entire liability and the customer's exclusive remedy under this 
license agreement shall be, at Diablo's option, either (a) return of the price paid for the software or (b) replacement of the 
software that does not meet Diablo's Limited Warranty and which is returned to Diablo with a copy of the customer's 
receipt.  Any replacement software will be warranted for the remainder of the original warranty period, or 30 days, 
whichever is longer.  These remedies are not available outside the United States of America. 
 
No Liability for Consequential Damages:  To the maximum extent permitted by applicable law, in no event shall Diablo be 
liable for any damages whatsoever (including, without limitation, damages for loss of business profit, business 
interruption, loss of business information, or any other pecuniary loss) arising out of the use or inability to use the product, 
even if Diablo has been advised of the possibility of such damages.  Because some states/jurisdictions do not allow the 
exclusion or limitation of liability for consequential or incidental damages, the above limitation may not apply to you. 
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Getting Started 

Introduction 
The MS Sensor Application Builder software is tool to help users develop direct sampling mass spectrometry 
applications where spectral interference must be considered (like applications for the Diablo 5000A Real-Time 
Gas Analyzer).  The Application Builder software uses the NIST Mass Spectral Library and the user's 
estimate of compound concentration to generate a combined sample spectrum and a table of sample m/z 
values with estimates of potential interference. 

Note:  You should expect some instrument-to-instrument variation in the actual mass spectra produced for a 
particular compound when compared with the NIST Library spectra used by Application Builder.  
Consequently, you should consider the Application Builder results to be estimates to help you with your 
evaluation of an application, rather than a rigorous and quantitative determination of the actual interferences. 

Software Requirements 

1) This software is supported on Windows 7 SP1, Windows 8/8.1, Windows 10, and Windows 11. 

2) The Microsoft .NET 4.7.2 Framework runtime must be installed.  If you are installing the MS Sensor 
software from the USB Flash drive installation media, then the runtime will be installed automatically if 
needed.  If you downloaded the software from our web site, then the installer will automatically download and 
install the runtime if needed.  If the computer is not connected to the Internet, then you will need to download 
the runtime file from our web site and copy it to the same folder as the installer. 

Alternatively, you can download the .NET 4.7.2 Framework runtime installer from Microsoft and install the 
runtime prior to installing the software. 

https://dotnet.microsoft.com/en-us/download/dotnet-framework/net472 

Note: if you are running a relatively recent version of Windows 10 (April 2018 Update - Version 1803 or later) 
or any version of Windows 11, then your system already has the runtime installed.  In addition, other 
programs may have already installed the runtime. 

IMPORTANT: The MS Sensor software has been designed, tested, and is intended for use on US/English 
versions of Microsoft Windows operating systems. 

NIST Mass Spectral Library 

This software requires the NIST Mass Spectral Library to be licensed and installed on the computer.  You can 
purchase a special, discounted license of the NIST 17 library at the time you purchase the Application Builder 
license. 

For more information on the NIST Mass Spectral Library, visit the following link: 

https://dotnet.microsoft.com/en-us/download/dotnet-framework/net472
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http://chemdata.nist.gov/ 

DEMO Library and Application 

If you choose the “Complete Setup” when installing the Application Builder software, then a small “demo” 
library and corresponding application file will be installed to help you evaluate the software. 

The demo library is installed to the folder: “C:\NIST DEMO\MSSEARCH\mssensor_demo” 

The demo application is:  C:\Users\Public\Documents\Diablo MS Sensor 4.0\Application Builder\ 
air_demo.mssapp 

IMPORTANT: The spectra included in the demo library are “synthetic” and were not derived experimentally or 
copied from an experimentally derived source like the NIST library.  Although they should resemble the actual 
spectra of those library compounds, you should only use them for demonstration and evaluation purposes. 

Installation 
Note:  We recommended installing the NIST Mass Spectral Library before installing the Application Builder 
software.  Refer to the NIST Mass Spectral Library User’s Guide for information on installing the library. 

The Application Builder software is installed by running the setup program on the distribution flash drive/CD, 
or the installation program downloaded from our web site.   

Important:  You must be logged on with Administrator privileges when you install the software (but you can 
run the software thereafter as a standard user) 

Software Licensing and Activation 
When you run the software for the first time, you will have a trial license that allows you to use and evaluate 
the program for up to 30 days.  The program is fully-functional during the trial period.  In order to continue 
using the software after the 30-day trial period, you must purchase a license and then activate the software. 

Note:  The Application Builder software is included with the MS Sensor 4.0 software.  After activating the MS 
Sensor 4.0 software running on the same computer, the Application Builder software will also reflect the MS 
Sensor 4.0 license status.  However, if you want to run the Application Builder software on a different 
computer, you will need to activate the software. 

To activate your license, click the “Activate License” button on the License Status window that is displayed 
when you start the software or when you click the menu option, “Help > License Status…”. 

http://chemdata.nist.gov/
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When you purchase your software license, you will receive a 31-character Serial License Code (this is 
different than the shorter Serial Number).  To activate the software, you must enter that License Code into the 
text box on the “Activate License” window.  If you copy the Serial License Code to the Windows Clipboard 
from an email message, you can paste into the text box using the “Paste” button.  Alternatively, if you 
received a text file containing the Serial License Code, you can load it using the “File Open” button. 

Note: If you received a distribution USB flash drive, a text file containing your serial license code may be 
saved on the flash drive. 
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After entering the Serial License Code, click the “Apply” button.  If your computer is connected to the Internet, 
the software will contact the License Server and automatically activate the software. 

If your computer is not connected to the Internet, or if there is a problem contacting the License Server, then 
you will need to activate the software manually by clicking the “Manual” button and following the instructions. 

Refer to the Software License Guide for more information about licensing and activation. 

Note: An Internet connection is only required when applying an activation code or deactivating the software.  
No Internet connection is required during normal operation of the software. 
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Guide to Application Builder 

 

Overview 
All of the functionality of the Application Builder software is accessed through the menus and panels of the 
main user interface.  Each of these elements is described in more detail below. 
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The Main Menu 

File Menu 

New Application:  Click this option to clear the current application and create a new application.  Make sure 
to save the current application if you want to load it at a later time. 

Open Application:  Click this option to load an existing application from disk.  Application files have a file 
extension of “.mssapp”, and are stored by default in the folder: 

C:\Users\Public\Documents\Diablo MS Sensor 4.0\Application Builder 

Save Application:  Click this option to save any changes you have made to the current application.  If you 
haven’t yet saved the application, then the “Save Application As” dialog will be displayed. 

Save Application As:  Click this option to save the current application to a new application file. 

Export Application to MS Sensor:  If the MS Sensor 4.0 software is installed on the current computer, you 
can click this menu option to export the current application to MS Sensor.  See the MS Sensor 4.0 reference 
manual for more information on how using the Application Data Import Wizard to create a new method from 
the application data. 

Print Report:  Click this option to print a report for the current application. 

Save Report As:  Click this option to save the report for the current application to an Adobe Acrobat “PDF” 
file. 

Set NIST Library Folder:  Use this option to change the NIST library folder used by Application Builder.  You 
would need to do this if you have multiple versions of the NIST Library installed on your system, or if you are 
using the Application Builder Demo Library and want to switch to the actual NIST Library.  NIST Libraries are 
typically installed in the folder, “C:\NISTXX\mssearch”, where “XX” is the release year.  Currently this folder is 
“C:\NIST17\mssearch.  You can select either the C:\NIST17 folder or the actual “mssearch” folder. 

Update NIST Numbers:  This is an advanced option that should only be used at the direction of Diablo 
Analytical Support when upgrading applications from older versions of Application Builder. 

Application Menu 

Edit Settings 

The “Edit Settings” menu option allows you to customize the behavior of the current application.  See the 
description of each setting below. 
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Application Description:  The Application Description is displayed in the printed or saved report. 

Interference Warning Level:  If the total interference from other compounds at a particular m/z is greater 
than this setting as a relative % of a compound’s corrected abundance at the same m/z, then an interference 
warning will be generated (the m/z will be shown in a yellow cell in the combined peaks table). 

Interference Failure Level:  If the total interference from other compounds at a particular m/z is greater than 
this setting as a relative % of a compound’s corrected abundance at the same m/z, then an interference 
failure will be generated (the m/z will be shown in a red cell in the combined peaks table). 

Abundance Threshold:  If the corrected abundance of a peak as a relative % of the base peak abundance is 
less than this setting, then this peak will be considered too low in intensity to use in the application (the m/z 
will be shown in a gray cell in the combined peaks table) 

Peak Label Threshold:  This sets the size of the peak in mass spectrum plots that will have the m/z label 
displayed at the top of the peak.  The setting is the % of the base peak abundance.  The purpose is to prevent 
peak labels on small peaks from complicating the display of the spectrum. 

Help Menu 

View Help:  Displays this help file. 

License Status:  Display the license status for the Application Builder software.  See “Software Licensing and 
Activation” on page 2 for information on activating the software. 

View Release Notes:  Opens the release notes (readme.txt) for the current software release in Windows 
Notepad.  You should always review the release notes when you install a new version of the software to see if 
there are any important changes that didn’t make it into the manual. 

About MS Sensor Application Builder:  Displays a window with information about the Application Builder 
software, including the version, and the current NIST Library folder being used. 

The Search Panel 

The Search Panel is the interface to the NIST Mass Spectral Library (or the small “demo” library if you have 
not installed the NIST library). 
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The Library List:  This list box will contain all of the libraries that are present in the current library folder.  In a 
typical NIST Mass Spectral Library installation, the only option will be “Mainlib”.  However, if you have created 
additional custom libraries in the same library folder, they will also be listed here. 

Library Search Options:  You can search the selected library by entering a Compound Name, a CAS 
Registry Number, or a Chemical Formula. 

Search Results:  After selecting the desired search options and entering the corresponding search term, click 
the “Search” button.  The names of any compounds in the selected library that match your search options will 
be displayed in the search results list (including compound aliases/synonyms).  If you select one of the search 
results, the mass spectrum and compound information will be displayed in the Spectrum Panel for review. 
 

 

The Spectrum Panel 

The Spectrum Panel is used to display the spectrum, peak table, and compound information of either a library 
search result, or of one of the compounds you have added to the combined peaks table. 

Mass Spectrum Tab 

The Mass Spectrum plot displays the spectrum of either the selected library search result or the selected 
compound in the combined peaks table. 
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Zooming:  You can zoom into the spectrum by left clicking the upper left of the desired zoom range, and then 
dragging the zoom rectangle to the lower right of the desired region.  You can un-zoom by double clicking 
anywhere in the plot window. 

Panning:  You can drag the spectrum to a new location by right clicking anywhere in the plot window and then 
dragging the entire spectrum to the desired location. 

Copying to the Clipboard:  You can copy the spectrum to the Windows Clipboard by right clicking anywhere 
on the spectrum and selecting “Copy Spectrum to Clipboard” from the pop-up menu. 

 

Peak Table Tab 

The Peak Table displays the spectrum of either the selected library search result or the selected compound in 
the combined peaks table in tabular form. 

Copy to clipboard:  You can select a region from the Peak Table and then copy it to the Windows Clipboard 
by right clicking the table and selecting, “Copy Selection to Clipboard” from the pop-up menu. 

 

Compound Information Tab 

The Compound Information table displays information about either the selected library search result or 
selected compound in the combined peaks table.  The information included in the table depends on the 
version of the NIST Library (or demo library) you have selected, but can include the CAS Number, Molecular 
Weight, and any synonyms that have been defined. 

Copy to clipboard:  You can select a region from the Compound Information table and then copy it to the 
Windows Clipboard by right clicking the table and selecting, “Copy Selection to Clipboard” from the pop-up 
menu. 
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The Combined Peaks Panel 

The Combined Peaks Panel is where the compounds you have added to your application are saved and 
displayed. 

Adding, Deleting, and Viewing Spectra 

Click the “Add” button to add the compound/spectrum currently displayed in the Spectrum Panel to your 
application.  You will be prompted to enter an estimated amount. 

Click the “Delete” button to delete the compound currently selected in the Combined Peaks Table from the 
application. 

You can display the mass spectrum, peak table, and compound information for any compound in your 
application either by selecting that compound in the “Display Compound” list, or by clicking the compound’s 
row in the Combined Peaks table. 

 

Combined Peaks Table 

The Combined Peaks table displays all of the m/z values present in the spectra of all of the compounds in 
your application.  In the default mode the table displays the corrected abundance for each m/z value in each 
compounds spectrum, allowing you to evaluate where there will be potential spectral interferences.   

Note:  Corrected Abundance = Normalized Abundance * Amount% / 100 
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Spectral interferences are calculated for each peak in a compound’s spectrum by adding the corrected 
abundance for all other compounds at a particular m/z, and then comparing that “interference” with the 
corrected abundance of the compound.  The cells in the table are then color coded as follows: 

 

Green: The total interference from other compounds at that same m/z is less than the “Interference 
Warning Level” in the Application Settings (less than 2% of the compound’s corrected 
abundance at this m/z by default) 

Yellow The total interference from other compounds at that same m/z is greater than the 
“Interference Warning Level” and less than the “Interference Failure Level” in the Application 
Settings (less than 25% of the compound’s corrected abundance at this m/z by default) 

Red The total interference from other compounds at that same m/z is greater than the 
“Interference Failure Level” in the Application Settings (greater than 25% of the compound’s 
corrected abundance at this m/z by default) 

Gray: The corrected abundance is less than the “Abundance Threshold” in the Application 
Settings (5% of the abundance of the base peak in this compound’s spectrum) 

 

You can review the detailed interference results for a particular peak by placing the cursor over the desired 
cell in the table – a “tool tip” will pop up displaying the detail.  You can also check the “Display detailed 
results” checkbox” (see “Display detailed results” on page 13). 
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Copy to clipboard:  You can select a region from the Combined Peaks table and then copy it to the Windows 
Clipboard by right clicking the table and selecting, “Copy Selection to Clipboard as Text” from the pop-up 
menu.  You can also copy the entire table to the clipboard by selecting “Copy Table to Clipboard as Image”. 

Changing Estimated Amounts 

You can change the estimated amount of any of the compounds in your application by double clicking the 
amount you want to change in the Combined Peaks table.  You can enter a new amount (in %) into the 
“Compound Amount” window.  After clicking “OK” your application will be updated to reflect the new amount. 

 

Combined Spectrum 

The Combined Spectrum plot is a spectrum that combines all of the individual corrected peak abundances at 
each m/z to produce an overall spectrum of the sample. 

Zooming:  You can zoom into the spectrum by left clicking the upper left of the desired zoom range, and then 
dragging the zoom rectangle to the lower right of the desired region.  You can un-zoom by double clicking 
anywhere in the plot window. 

Panning:  You can drag the spectrum to a new location by right clicking anywhere in the plot window and then 
dragging the entire spectrum to the desired location. 

Copying to the Clipboard:  You can copy the spectrum to the Windows Clipboard by right clicking anywhere 
on the spectrum and selecting “Copy Spectrum to Clipboard” from the pop-up menu. 
 

 

Sync mass range of spectra 

If you check the “Sync mass range of spectra” option, then each of the individual spectra displayed in the 
Mass Spectrum tab will have the full mass range of the combined spectrum.  If this option is unchecked, then 
the individual spectra in the Mass Spectrum tab will be displayed over the mass range of peaks present in 
that compound’s spectrum. 
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Display detailed results 

If you check this option, then the combined peak table will be expanded to include the following detail: 

 

Line 1:  The corrected abundance (normalized peak abundance x concentration estimate / 100) 

Line 2:  The normalized abundance of the peak in the spectrum (with the % of the base peak in parenthesis).  
The base peak is the peak with the highest abundance in the spectrum. 

Line 3:  The total interference from other compounds at that m/z (and the relative % this interference 
represents of the compound’s corrected abundance). 

Note:  The relative% of the interference is the value used to set interference and failure warnings. 

Building an Application 
The following approach is typically used to build and evaluate an application using Application Builder: 

Define Your Sample 

In order to make the application evaluation meaningful, you should first identify all of the compounds that 
could potentially be present in your sample and estimate the maximum concentration you expect for them.  
Make sure to include any diluent/makeup gas, and any other components that might be present like water 
vapor or atmospheric nitrogen and oxygen. 

Create the Application 

Once you have defined your sample, you can create a new application by searching the library for each 
compound in your sample and adding it to the application by clicking the “Add” button.  You will be prompted 
to enter the estimated concentration (in %) for that compound: 

 

After adding a compound to the application, the Combined Peaks table and spectrum will be updated to 
reflect the impact the new compound has on the application. 

Evaluate the Results 

When you have added all of the compounds in your sample to the application, you can evaluate the 
interference levels as indicated by the color-coding of the cells for each m/z in the Combined Peaks table (see 
“Combined Peaks Table” on page 10 for details). 

Application Builder will select the “best” m/z value to monitor for each compound in the application and display 
that in the “Selected m/z” column of the Combined Peaks table: 
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Note: If there are no m/z values for a particular compound that have interference values fall below the 
Interference Failure Level set for your application, then the “Selected M/Z” will be left blank, and the 
compound name will be displayed in red to indicate there are potentially significant issues with the compound 
in the current application. 

You can override the “Selected M/Z” for a particular compound by right clicking on the cell in the Combined 
Peaks table for the desired m/z, and select “Manually Select this M/Z for Compound” from the pop-up menu.  
Manually selected m/z values are displayed in italics in the “Selected M/Z” column. 

Refine the Results 

Once you have done your initial evaluation it is often helpful to refine the results by adjusting the estimated 
compound amounts to see the impact on the interference analysis.  You can also add/remove compounds 
from the application depending on the experimental flexibility you have.  For example you can assess different 
diluent/make up gases to see how they impact the application. 

Save the Application 

You can save your application so that it can be recalled at a later time by clicking the “File > Save…” or “File > 
Save As…” menu options.  Application files have a file extension of “.mssapp”, and are stored by default in 
the folder: 

C:\Users\Public\Documents\Diablo MS Sensor 4.0\Application Builder 

Save and Print the Report 

Finally, you can save or print an Application Builder Report using the “File > Print Report…” or “File > Save 
Report As…” menu options. 
 



 

MS Sensor 4.0 Application Builder 15 

Index 

A 

About MS Sensor Application Builder 7 
Adding, Deleting, and Viewing Spectra 10 
Application Menu 6 

B 

Building an Application 13 

C 

Changing Estimated Amounts 12 
Combined Peaks Table 10 
Combined Spectrum 12 
Compound Information Tab 9 

D 

DEMO Library and Application 2 
Display detailed results 13 

E 

Edit Settings 6 

F 

File Menu 6 

G 

Getting Started 1 
Guide to Application Builder 5 

H 

Help Menu 7 

I 

Installation 2 

Introduction 1 

L 

Library Search Options 7 
License Status 7 

M 

Mass Spectrum Tab 8 

N 

New Application 6 
NIST Mass Spectral Library 1 

O 

Open Application 6 
Overview 5 

P 

Peak Table Tab 9 
Print Report 6 

S 

Save Application As 6 
Save Report As 6 
Search Results 7 
Set NIST Library Folder 6 
Software Licensing and Activation 2 
Software Requirements 1 
Sync mass range of spectra 12 

T 

The Combined Peaks Panel 10 
The Library List 7 
The Main Menu 6 
The Search Panel 7 
The Spectrum Panel 8 

V 

View Help:  Displays this help file. 7 

 


	Diablo Analytical MS Sensor 4.0
	Getting Started
	Introduction
	Software Requirements
	NIST Mass Spectral Library
	DEMO Library and Application

	Installation
	Software Licensing and Activation

	Guide to Application Builder
	Overview
	The Main Menu
	File Menu
	Application Menu
	Help Menu

	The Search Panel
	The Spectrum Panel
	Mass Spectrum Tab
	Peak Table Tab
	Compound Information Tab

	The Combined Peaks Panel
	Adding, Deleting, and Viewing Spectra
	Combined Peaks Table
	Changing Estimated Amounts
	Combined Spectrum
	Sync mass range of spectra
	Display detailed results


	Building an Application

	Index

